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 Important Information

Warranty
The PXI-8461 is warranted against defects in materials and workmanship for a period of one year from the date of 
shipment, as evidenced by receipts or other documentation. National Instruments will, at its option, repair or replace 
equipment that proves to be defective during the warranty period. This warranty includes parts and labor. 

The media on which you receive National Instruments software are warranted not to fail to execute programming 
instructions, due to defects in materials and workmanship, for a period of 90 days from date of shipment, as evidenced 
by receipts or other documentation. National Instruments will, at its option, repair or replace software media that do not 
execute programming instructions if National Instruments receives notice of such defects during the warranty period. 
National Instruments does not warrant that the operation of the software shall be uninterrupted or error free.

A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outside 
of the package before any equipment will be accepted for warranty work. National Instruments will pay the shipping costs 
of returning to the owner parts which are covered by warranty.

National Instruments believes that the information in this manual is accurate. The document has been carefully reviewed 
for technical accuracy. In the event that technical or typographical errors exist, National Instruments reserves the right to 
make changes to subsequent editions of this document without prior notice to holders of this edition. The reader should 
consult National Instruments if errors are suspected. In no event shall National Instruments be liable for any damages 
arising out of or related to this document or the information contained in it.

EXCEPT AS SPECIFIED HEREIN, NATIONAL  INSTRUMENTS MAKES NO WARRANTIES, EXPRESS OR IMPLIED, AND SPECIFICALLY DISCLAIMS 
ANY WARRANTY OF MERCHANTABILITY  OR FITNESS FOR A PARTICULAR PURPOSE. CUSTOMER’ S RIGHT TO RECOVER DAMAGES CAUSED 
BY FAULT OR NEGLIGENCE ON THE PART OF NATIONAL  INSTRUMENTS SHALL BE LIMITED  TO THE AMOUNT THERETOFORE PAID BY THE 
CUSTOMER. NATIONAL  INSTRUMENTS WILL  NOT BE LIABLE  FOR DAMAGES RESULTING FROM LOSS OF DATA, PROFITS, USE OF PRODUCTS, 
OR INCIDENTAL OR CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY THEREOF. This limitation of the liability of 
National Instruments will apply regardless of the form of action, whether in contract or tort, including negligence. 
Any action against National Instruments must be brought within one year after the cause of action accrues. National 
Instruments shall not be liable for any delay in performance due to causes beyond its reasonable control. The warranty 
provided herein does not cover damages, defects, malfunctions, or service failures caused by owner’s failure to follow 
the National Instruments installation, operation, or maintenance instructions; owner’s modification of the product; 
owner’s abuse, misuse, or negligent acts; and power failure or surges, fire, flood, accident, actions of third parties, 
or other events outside reasonable control.

Copyright
Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mechanical, 
including photocopying, recording, storing in an information retrieval system, or translating, in whole or in part, without 
the prior written consent of National Instruments Corporation.

Trademarks
BridgeVIEW™, LabVIEW™, CVI™, Lookout™, natinst.com™, NI-CAN™, and NI-DNET™ are trademarks of National 
Instruments Corporation.

Product and company names listed are trademarks or trade names of their respective companies.

WARNING REGARDING MEDICAL AND CLINICAL USE OF NATIONAL INSTRUMENTS PRODUCTS
National Instruments products are not designed with components and testing intended to ensure a level of reliability 
suitable for use in treatment and diagnosis of humans. Applications of National Instruments products involving medical 
or clinical treatment can create a potential for accidental injury caused by product failure, or by errors on the part of the 
user or application designer. Any use or application of National Instruments products for or involving medical or clinical 
treatment must be performed by properly trained and qualified medical personnel, and all traditional medical safeguards, 
equipment, and procedures that are appropriate in the particular situation to prevent serious injury or death should always 
continue to be used when National Instruments products are being used. National Instruments products are NOT intended 
to be a substitute for any form of established process, procedure, or equipment used to monitor or safeguard human health 
and safety in medical or clinical treatment.
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 Compliance

FCC/DOC Radio Frequency Interference 
Class A Compliance

This equipment generates and uses radio frequency energy and, if not installed and used in strict accordance 
with the instructions in this manual, may cause interference to radio and television reception. Classification 
requirements are the same for the Federal Communications Commission (FCC) and the Canadian 
Department of Communications (DOC). This equipment has been tested and found to comply with the 
following two regulatory agencies:

Federal Communications Commission
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant 
to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful 
interference when the equipment is operated in a commercial environment. This equipment generates, 
uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction 
manual, may cause harmful interference to radio communications. Operation of this equipment in a 
residential area is likely to cause harmful interference in which case the user will be required to correct the 
interference at his own expense.

Notices to User: Changes or modifications not expressly approved by National Instruments could void 
the user’s authority to operate the equipment under the FCC Rules.

If necessary, consult National Instruments or an experienced radio/television technician for additional 
suggestions. The following booklet prepared by the FCC may also be helpful: Interference to Home 
Electronic Entertainment Equipment Handbook. This booklet is available from the U.S. Government 
Printing Office, Washington, DC 20402.

Canadian Department of Communications
This Class A digital apparatus meets all requirements of the Canadian Interference-Causing Equipment 
Regulations.
Cet appareil numérique de la classe A respecte toutes les exigences du Règlement sur le matériel brouilleur 
du Canada.

Win95.book  Page 4  Thursday, July 23, 1998  8:40 AM



© National Instruments Corporation v Getting Started with DeviceNet for Windows 95/98

Contents

About This Manual
How to Use the Manual Set ............................................................................................. ix
Organization of This Manual ...........................................................................................x
Conventions Used in This Manual...................................................................................x
Related Documentation....................................................................................................xi
Customer Communication ...............................................................................................xi

Chapter 1
Introduction

How to Use This Manual .................................................................................................1-1
What You Need to Get Started ........................................................................................1-2
DeviceNet Hardware Overview.......................................................................................1-2
NI-DNET Software Overview .........................................................................................1-3
Optional Programming Tools ..........................................................................................1-3

Chapter 2
Installation

Install the NI-DNET Software.........................................................................................2-1
Install the Hardware.........................................................................................................2-3

Install Your PXI-8461 .......................................................................................2-3
Connect the Cables ............................................................................................2-5

Chapter 3
Verify the Installation

Run the NI-DNET Hardware Configuration Utility ........................................................3-1
Test Installed DeviceNet Ports ..........................................................................3-1
Changing an Interface Name.............................................................................3-2

Chapter 4
Begin to Use the NI-DNET Software

NI-DNET Application Example ......................................................................................4-1
SingleDevice......................................................................................................4-1
Run the Example ...............................................................................................4-2

General Programming Considerations.............................................................................4-5

Win95.book  Page v  Thursday, July 23, 1998  8:40 AM



Contents

Getting Started with DeviceNet for Windows 95/98 vi © National Instruments Corporation

Appendix A
Uninstalling the Hardware and Software

Uninstalling the Hardware from Windows 95/98 ........................................................... A-1
Uninstalling the NI-DNET Software from Windows 95/98............................................ A-3

Appendix B
Cabling Requirements

Connector Pinouts ........................................................................................................... B-1
Power Supply Information for the DeviceNet Ports........................................................ B-2
Cable Specifications ........................................................................................................ B-3
Cable Lengths..................................................................................................................B-3
Maximum Number of Devices ........................................................................................ B-4
Cable Termination ........................................................................................................... B-4
Cabling Example ............................................................................................................. B-5

Appendix C
Troubleshooting and Common Questions

Hardware Configuration Utility Test Failures................................................................. C-1
Memory Resource Conflict ............................................................................... C-1
Interrupt Resource Conflict............................................................................... C-1
NI-DNET Software Problem Encountered ....................................................... C-2
Missing Board in Hardware Configuration Utility ........................................... C-2
Hardware Problem Encountered ....................................................................... C-2

Device Manager Problems .............................................................................................. C-2
No National Instruments CAN Interfaces......................................................... C-3
Missing Board in Device Manager ................................................................... C-3
Problem Shown in Device Manager ................................................................. C-3

Common Questions ......................................................................................................... C-6

Appendix D
Specifications

Appendix E
Customer Communication

Win95.book  Page vi  Thursday, July 23, 1998  8:40 AM



Contents

© National Instruments Corporation vii Getting Started with DeviceNet for Windows 95/98

Glossary

Figures
Figure 2-1. Add/Remove Programs Properties Dialog Box.......................................2-1
Figure 2-2. NI-DNET Software Setup Screen ...........................................................2-2
Figure 2-3. Installing the PXI-8461 ...........................................................................2-4

Figure 3-1. NI-DNET Hardware Configuration Utility after Testing........................3-2
Figure 3-2. Interface Name Change Dialog Box .......................................................3-3

Figure 4-1. SingleDevice Front Panel........................................................................4-2

Figure A-1. Selecting an Interface to Remove from Windows 95/98 ........................A-2
Figure A-2. Add/Remove Programs Properties Dialog Box.......................................A-3
Figure A-3. NI-DNET Uninstallation Results ............................................................A-4

Figure B-1. Pinout for 5-Pin Combicon-Style Pluggable Screw Terminal ................B-1
Figure B-2. PXI-8461 Power Source Jumper .............................................................B-2
Figure B-3. Power Source Jumpers ............................................................................B-3
Figure B-4. Termination Resistor Placement .............................................................B-4
Figure B-5. Cabling Example .....................................................................................B-5

Figure C-1. Device Manager with PXI-8461 Interface Not Working Properly .........C-4

Tables
Table B-1. Power Requirements for the DeviceNet Physical Layer 

for Bus-Powered Versions.......................................................................B-2
Table B-2. DeviceNet Cable Length Specifications..................................................B-4

Table D-1. PXI-8461 Characteristics ........................................................................D-1
Table D-2. DeviceNet Port Characteristics for Bus-Powered Ports ..........................D-1

Win95.book  Page vii  Thursday, July 23, 1998  8:40 AM



© National Instruments Corporation ix Getting Started with DeviceNet for Windows 95/98

About This Manual

This manual contains instructions to help you install and configure the 
National Instruments PXI-8461 and the NI-DNET software for 
Windows 95/98.

This manual assumes that you are already familiar with Windows 95/98.

How to Use the Manual Set

Use this getting started manual to install and configure your PXI-8461 and 
the NI-DNET software for Windows 95/98.

Use the NI-DNET User Manual to learn the basics of DeviceNet and how 
to develop an application program. The user manual also contains detailed 
examples.

Use the NI-DNET Programmer Reference Manual for specific information 
about each NI-DNET function and object, including format, parameters, 
and possible errors.

NI-DNET
User Manual

Application
Development
and Examples

First-Time
NI-DNET Users

Experienced
NI-DNET Users

NI-DNET
Programmer

Reference Manual

Function
and Object

Descriptions

Getting Started
Manual

Installation and
Configuration
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Organization of This Manual
This manual is organized as follows:

• Chapter 1, Introduction, explains how to use this manual, lists what 
you need to get started, provides a brief overview of the PXI-8461 and 
the NI-DNET software for Windows 95/98, and describes optional 
equipment you can order.

• Chapter 2, Installation, describes how to install the NI-DNET software 
for Windows 95/98 and the PXI-8461 hardware.

• Chapter 3, Verify the Installation, describes how to verify the hardware 
and software installation and make any necessary changes to the 
configuration.

• Chapter 4, Begin to Use the NI-DNET Software, helps you get started 
with the NI-DNET software for Windows 95/98.

• Appendix A, Uninstalling the Hardware and Software, describes how 
to uninstall the PXI-8461 hardware and the NI-DNET software for 
Windows 95/98.

• Appendix B, Cabling Requirements, describes the cabling 
requirements for the hardware.

• Appendix C, Troubleshooting and Common Questions, describes how 
to troubleshoot problems and answers some common questions.

• Appendix D, Specifications, describes the physical characteristics of 
the hardware and the recommended operating conditions.

• Appendix E, Customer Communication, contains forms you can use to 
request help from National Instruments or to comment on our products 
and manuals.

• The Glossary contains an alphabetical list and a description of terms 
used in this manual, including abbreviations, acronyms, metric 
prefixes, mnemonics, and symbols.

Conventions Used in This Manual
The following conventions are used in this manual:

» The » symbol leads you through nested menu items and dialog box options 
to a final action. The sequence File»Page Setup»Options»Substitute 
Fonts directs you to open the File menu, select the Page Setup item, select 
Options, and finally select the Substitute Fonts option from the last dialog 
box.
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This icon to the left of bold italicized text denotes a caution, which advises 
you of precautions to take to avoid injury, data loss, or a system crash.

bold Bold text denotes the names of menus, menu items, dialog boxes, dialog 
box buttons or options, icons, windows, Windows 95/98 tabs, or LEDs.

bold italic Bold italic text denotes a caution.

italic Italic text denotes emphasis, a cross reference, or an introduction to a key 
concept.

monospace Text in this font denotes text or characters that you should literally enter 
from the keyboard, sections of code, programming examples, and syntax 
examples. This font is also used for the proper names of disk drives, paths, 
directories, programs, subprograms, subroutines, device names, functions, 
parameters, operations, variables, filenames, and extensions, and for 
statements and comments taken from program code.

paths Paths in this manual are denoted using backslashes (\) to separate drive 
names, directories, folders, and files.

Related Documentation
The following documents contain information that you may find helpful as 
you read this manual:

• CompactPCI Specification, Revision 2.0, PCI Industrial Computers 
Manufacturers Group

• DeviceNet Specification, Version 2.0, Open DeviceNet Vendor 
Association

• Microsoft Windows 95/98 User’s Guide, Microsoft Corporation

• PXI Specification, Revision 1.0, National Instruments Corporation

Customer Communication
National Instruments wants to receive your comments on our products 
and manuals. We are interested in the applications you develop with our 
products, and we want to help if you have problems with them. To make it 
easy for you to contact us, this manual contains comment and configuration 
forms for you to complete. These forms are in Appendix E, Customer 
Communication, at the end of this manual. 

!
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1
Introduction

This chapter explains how to use this manual, lists what you need to get 
started, provides an overview of the PXI-8461 and the NI-DNET software 
for Windows 95/98, and describes optional equipment you can order.

How to Use This Manual

Yes

No

Chapter 3

Chapter 4

User Manual and
Programmer Reference

Manual
Write Application Program

Passes?

Gather What You Need
to Get Started

Chapter 1

Install the Hardware

Install the Software

Verify the Installation

Review Programming
Considerations

Troubleshooting
Appendix

Chapter 2
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What You Need to Get Started
Make sure you have all of the following items before you attempt to install 
the hardware and software:

❑ Windows 95 or Windows 98 installed on your computer

❑ PXI-8461 board

❑ The following 3.5 in., high-density (1.44 MB) disks, which are 
included in your kit:

NI-DNET Software for Windows 95/98 and Windows NT (Disk 1 of 3)
NI-DNET Software for Windows 95/98 and Windows NT (Disk 2 of 3)
NI-DNET Software for Windows 95/98 and Windows NT (Disk 3 of 3)

❑ DeviceNet interface cables that meet the requirements in Appendix B, 
Cabling Requirements

DeviceNet Hardware Overview
The PXI-8461 is software configurable and compliant with the PXI 
Specification, CompactPCI Specification, and DeviceNet Specification. 
With a PXI-8461, you can make your PC-compatible computer with 
PCI Local Bus slots communicate with and control DeviceNet devices.

The DeviceNet physical communication link protocol is based on the 
Controller Area Network (CAN) protocol. The physical layer of the 
PXI-8461 fully conforms to the DeviceNet physical layer requirements. 
The physical layer is optically isolated to 500 volts and is powered from the 
DeviceNet bus power supply. DeviceNet interfacing is accomplished using 
the Intel 82527 CAN controller chip. For more information on the 
DeviceNet physical layer and cables used to connect to your DeviceNet 
devices, see Appendix B, Cabling Requirements.

The PXI-8461 is available with two physical connector types: 

• Combicon-style pluggable screw terminals (as required by the 
DeviceNet Specification)

• DB-9 D-Sub (for non-DeviceNet applications)

The PXI-8461 uses the Intel 386EX embedded processor to implement 
time-critical features provided by the NI-DNET software. The board 
communicates with the NI-DNET driver through on-board shared memory 
and an interrupt.
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NI-DNET Software Overview
The NI-DNET software includes a native, 32-bit multitasking Windows 
driver that is fully Plug and Play aware. The driver components are 
dynamically loaded when Windows detects new hardware and dynamically 
unloaded when Windows detects the removal of hardware.

The NI-DNET software for Windows 95/98 supports the concurrent use of 
multiple DeviceNet-compliant boards. For example, you can use both a 
PXI-8461 and a PCMCIA-CAN in the same system at the same time. 

The NI-DNET software, along with the PXI-8461, transforms your 
computer into a DeviceNet interface with complete communications 
capability. The NI-DNET software can act as a DeviceNet master in order 
to communicate with up to 63 slave devices. Communication capabilities 
include explicit messaging, polled I/O, strobed I/O, and change-of-state/ 
cyclic I/O. The NI-DNET software can also act as a DeviceNet slave.

The NI-DNET software includes the following components:

• Firmware (runs on embedded Intel 386EX)

• Device driver

• Hardware Configuration utility

• Language interface libraries for Microsoft Visual C/C++ 2.0 or later, 
Borland C/C++ 5.0 or later, LabWindows/CVI 4.0 or later, and 
LabVIEW 4.0 or later

• Example programs that use NI-DNET functions

• WinDnet support files

The NI-DNET software components are described in more detail in 
Chapter 1, Introduction, of the NI-DNET User Manual.

Optional Programming Tools
Your kit includes the NI-DNET software for Windows 95/98. In addition, 
you can order the LabWindows/CVI, LabVIEW, BridgeVIEW, or Lookout 
software from National Instruments.

LabWindows/CVI is an interactive ANSI C development environment for 
building test and measurement and instrument control systems. It includes 
interactive code generation tools and a graphical editor for building custom 
user interfaces. It also includes built-in libraries for IEEE 488.2, VXI, 
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RS-232 control, and plug-in data acquisition. When you order 
LabWindows/CVI, you also get hundreds of complete instrument drivers, 
which are modular, source-code programs that handle the communication 
with your instrument so that you do not have to learn the programming 
details.

LabVIEW is a complete programming environment that departs from the 
sequential nature of traditional programming languages and features a 
graphical programming environment. It includes all the tools needed for 
instrument control, data acquisition, analysis, and presentation. LabVIEW 
also includes an extensive instrument driver library.

BridgeVIEW is a radical departure from traditional automation software 
that provides a flexible program development system for a variety of 
DeviceNet applications including general manufacturing, test, and control. 
Leveraging National Instruments’ patented graphical programming 
language G (otherwise known as LabVIEW), BridgeVIEW gives you the 
ability to integrate functionality in a way that is not possible with traditional 
automation software. In addition to the programming advantages of G, 
BridgeVIEW also provides a number of powerful features for the 
development of your industrial automation application: graphical HMI 
(Human Machine Interface); ease of use; fill-in-the-blank configuration 
utilities; HMI G Wizard for simplified HMI development; historical data 
collection and trending; alarm and event reporting and logging; security; 
and connectivity to PLCs and industrial device networks like DeviceNet.

Lookout is a software package that gives users an object-oriented, 
event-driven environment for building a variety of applications including 
HMI, large supervisory control and data acquisition (SCADA) 
applications, discrete manufacturing, batch applications, and telemetry 
systems. Lookout utilizes a graphical interface and requires no 
programming or scripting. Lookout’s unique object-oriented approach 
increases productivity while reducing engineering design and maintenance 
costs. Unlike products that offer graphical user interfaces objects, Lookout 
is actually object-oriented in all aspects of system development. With 
Lookout, tasks such as driver setup, database configuration, historical 
logging, security management, and more are combined into a single, 
integrated system. 

For more information about LabWindows/CVI, LabVIEW, BridgeVIEW, 
and Lookout, contact National Instruments.
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2
Installation

This chapter describes how to install the NI-DNET software for 
Windows 95/98 and the PXI-8461 hardware.

Install the NI-DNET Software
Before you install your hardware, complete the following steps to install 
the NI-DNET software:

1. Select Start»Settings»Control Panel.

2. Double-click on the Add/Remove Programs icon in the Control Panel 
to launch the Add/Remove Programs applet. A dialog box similar to 
the one in Figure 2-1 appears.

Figure 2-1.  Add/Remove Programs Properties Dialog Box
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3. Click on the Install  button.

4. When prompted, insert the NI-DNET Software for Windows 95/98 and 
Windows NT (Disk 1 of 3), and click on the Next button to proceed. 
The software installation wizard begins with the screen shown in 
Figure 2-2.

Figure 2-2.  NI-DNET Software Setup Screen

The setup wizard guides you through the necessary steps to install the 
NI-DNET software. You may go back and change values where 
appropriate by clicking on the Back button. You can exit the setup 
where appropriate by clicking on the Cancel button.

5. Shut down Windows and turn off your computer when you complete 
the setup.

6. Proceed to the next section, Install the Hardware.
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Install the Hardware
This section describes how to install your PXI-8461.

Install Your PXI-8461

Caution Before you remove the board from the package, touch the antistatic plastic 
package to a metal part of your system chassis to discharge electrostatic energy, 
which can damage several components on your board.

1. Make sure that your PXI or CompactPCI chassis is turned off. Keep 
the PXI or CompactPCI chassis plugged in so that it remains 
grounded while you install the PXI-8461.

2. Choose an unused PXI or CompactPCI 5 V peripheral slot.

3. Remove the filler panel for the peripheral slot you have chosen.

4. Touch a metal part on your chassis to discharge any static 
electricity that might be on your clothes or body.

5. If you plan to use your PXI-8461 in a non DeviceNet-compliant 
system where bus power is not available, you need to configure the 
power supply jumpers on your board. See Appendix B, Cabling 
Requirements, for more information.

6. Insert the PXI-8461 into the selected 5 V slot. Use the 
injector/ejector handle to fully inject the device into place. 
Figure 2-3 shows how to install the PXI-8461 into a PXI or 
CompactPCI chassis.

!
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Figure 2-3.  Installing the PXI-8461

7. Screw the front panel of the PXI-8461 to the front panel mounting 
rail of the PXI or CompactPCI chassis.

8. Turn on your PXI or CompactPCI chassis and start Windows 95/98. 
Windows 95/98 should automatically detect the hardware and 
determine which driver is appropriate. A New Hardware Found 
dialog box appears, then goes away on its own. If the dialog box 
does not go away, select Windows Default Driver and click on the 
OK  button.

If the New Hardware Found dialog box does not appear when you 
restart Windows 95/98, refer to the Device Manager Problems 
section in Appendix C, Troubleshooting and Common Questions.

When you have finished installing the hardware, proceed to the next 
section, Connect the Cables.

1 Injector/Ejector Handle (In Down Position)
2 PXI-8461 Board

3 PXI Chassis
4 Injector/Ejector Rail

8

7

6

5

4

3

2

1

ON

STANDBY

4

1

2

3
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Connect the Cables
After you have installed your board, connect the DeviceNet cables to the 
PXI-8461. Because exact cabling requirements vary for each application, 
National Instruments does not provide DeviceNet cables. Refer to 
Appendix B, Cabling Requirements, for information about the cabling 
requirements of the hardware.

The PXI-8461 installation is now complete. Proceed to Chapter 3, Verify 
the Installation, to verify that your hardware and software installed 
correctly.
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3
Verify the Installation

This chapter describes how to verify the hardware and software installation 
and make any necessary changes to the configuration.

Run the NI-DNET Hardware Configuration Utility
You can use the NI-DNET Hardware Configuration utility, installed with 
your NI-DNET software, to test the hardware and software installation. The 
utility verifies that your hardware and software are functioning properly 
and that the configuration of your hardware does not conflict with anything 
else in your system.

To run the utility, select the Hardware Configuration item under 
Start»Programs»NI-DNET Software.

Test Installed DeviceNet Ports
The main listing of the NI-DNET Hardware Configuration utility displays 
each installed PXI-8461 board. If you have physically installed your board 
but it is not listed in the NI-DNET Hardware Configuration utility, check 
the Windows Device Manager to see if Windows 95/98 has detected the 
board. For more information, refer to the Device Manager Problems 
section in Appendix C, Troubleshooting and Common Questions.

To view information about a board’s physical DeviceNet ports, click on the 
plus sign next to the board’s name in the list. Since the NI-DNET software 
supports only single port hardware, the utility displays Port 1 for each 
installed board.

To run a hardware and software diagnostic test for all installed DeviceNet 
ports, select Test All from the Test menu. A progress bar displays the 
progression of the diagnostic test. When the diagnostic tests are complete, 
a checkmark next to a DeviceNet port indicates successful diagnostic 
testing, and an X indicates failure.
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Figure 3-1 shows the NI-DNET Hardware Configuration utility after it has 
tested a PXI-8461 board.

Figure 3-1.  NI-DNET Hardware Configuration Utility after Testing

If each installed DeviceNet port is shown with a checkmark, you are ready 
to use the NI-DNET software. Select Exit  from the File menu and proceed 
to Chapter 4, Begin to Use the NI-DNET Software.

If the diagnostic test fails for any port, you can find information on the 
failure by selecting the failed port name in the list then double-clicking on 
the Status field to the right. Use that help text and the information in 
Appendix C, Troubleshooting and Common Questions, to troubleshoot the 
problem.

After you have resolved a diagnostic failure for a particular DeviceNet port, 
you can test that port again by selecting it from the list then selecting Test 
One from the Test menu.

If you want to refresh the diagnostic status of all DeviceNet ports in order 
to run the diagnostic tests again, select Refresh from the View menu.

Changing an Interface Name
When you select a DeviceNet port in the list, the Interface Name for that 
port is shown to the right. This NI-DNET interface name is used within 
your application as a reference to the selected DeviceNet port. For a single 
DeviceNet board, the default NI-DNET interface name is DNET0.
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If you want to change the NI-DNET interface name which is associated 
with a port, double-click on the port name. The resulting dialog box 
provides an Interface Name drop-down box that you can use to select 
DNET0, DNET1, and so on. Changing the NI-DNET interface name is 
normally done only when you have multiple boards in your system. For 
example, if you have two PXI-8461 boards installed, you would normally 
assign one board as DNET0 and the other as DNET1.

Figure 3-2 shows the dialog box used to change a port’s NI-DNET interface 
name.

Figure 3-2.  Interface Name Change Dialog Box
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4
Begin to Use the NI-DNET 
Software

This chapter helps you get started with the NI-DNET software for 
Windows 95/98.

NI-DNET Application Example
The section introduces you to the NI-DNET software using 
SingleDevice , an example that accomplishes I/O communication as a 
DeviceNet master with a single slave device.

SingleDevice
This example accomplishes I/O communication as a DeviceNet master 
with a single slave device. You can use this example with any type of 
DeviceNet slave device. This example should be a starting point for you to 
learn to use the NI-DNET software.

The LabVIEW front panel for this example is shown in Figure 4-1. The 
LabWindows/CVI front panel is similar.
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Figure 4-1.  SingleDevice Front Panel

Run the Example
Follow these steps to run the example:

1. Connect a single DeviceNet slave device to your DeviceNet interface. 
For information on DeviceNet cabling, refer to Appendix B, Cabling 
Requirements.

2. Determine the baud rate and MAC ID used by your slave device.

Many devices provide external switches for the MAC ID and baud rate. 
If this is the case, consult the documentation provided by your device’s 
vendor.
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If your device does not have baud rate and MAC ID external switches, 
the baud rate is often fixed at 125,000 (or determined by the device 
automatically), and the MAC ID is configured using a network 
management utility. For information on network management utilities, 
refer to Chapter 3, NI-DNET Programming Techniques, in the 
NI-DNET User Manual.

If you know the baud rate of your device but not the MAC ID, 
NI-DNET provides a utility used to tell you the MAC ID of each 
connected device (SimpleWho ). For information on SimpleWho , refer 
to Chapter 3, NI-DNET Programming Techniques, in the NI-DNET 
User Manual.

3. Determine the type of I/O communication supported by your 
DeviceNet device. For example, most photoelectric sensors support 
strobed I/O with an input length of 1 byte. You need to know the I/O 
connection type (poll, strobe, and so on), number of input bytes, and 
number of output bytes.

This information should be included in the documentation provided by 
your device’s vendor. If not, you can use the SimpleWho  utility 
mentioned in Step 2 to find the information.

4. Load SingleDevice  into your programming environment.

• LabVIEW or BridgeVIEW: Select File»Open, then find 
SingleDevice.vi  in the LabVIEW or BridgeVIEW Examples  
directory.

• LabWindows/CVI: Select File»Open»Project, then find 
SingleDevice.prj  in the LabWindows/CVI Samples  
directory.

• For other programming environments, such as Microsoft C/C++, 
you can open SingleDevice.c  in the NI-DNET Examples  
directory. Since the steps needed to edit, compile, and run 
SingleDevice.c  are specific to your programming 
environment, the following steps provide information only for 
LabVIEW, BridgeVIEW, or LabWindows/CVI.

5. Change the front panel controls to match the capabilities of your slave 
device.

For LabVIEW or BridgeVIEW, you must change the front panel 
controls prior to running the example.

For LabWindows/CVI, you must first run the example in order to 
access the front panel controls.
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• Interface Name: This name selects the DeviceNet interface to 
use. If you only have one National Instruments DeviceNet board 
installed, the default DNET0 is appropriate.

• Interface MAC ID : This selects the DeviceNet MAC ID to use 
for your National Instruments DeviceNet board (it does not refer 
to a device). If you do not know of an unused MAC ID in your 
network, a MAC ID of 0 is often acceptable.

• Baud Rate: This selects the baud rate used by your DeviceNet 
device. Enter the value you determined in Step 2.

• Poll Mode: Leave this control set to Automatic .

• Device MAC ID: This selects the MAC ID of your DeviceNet 
device. Enter the value you determined in Step 2.

• Connection Type: This selects the type of I/O connection to use 
with your DeviceNet device. Enter the value you determined in 
Step 3.

• Input Length : This selects the number of bytes to read from the 
device’s I/O connection. Enter the value you determined in Step 3.

• Output Length: This selects the number of bytes to write to the 
device’s I/O connection. Enter the value you determined in Step 3.

• Exp Packet Rate: This determines the rate of I/O communication. 
Since you set Poll Mode to Automatic , if you specified a 
Connection Type of Strobe  or Poll , then this rate is determined 
automatically by NI-DNET, and the value in this control is 
ignored (you can leave it zero). If you specified a Connection 
Type of COS, set this control to 10000 . If you specified a 
Connection Type of Cyclic , set this control to 100 .

6. Start I/O communication.

For LabVIEW or BridgeVIEW, click on the Run button (right arrow) 
on the LabVIEW/BridgeVIEW menu bar to run the example.

For LabWindows/CVI, click on the Start button on the example’s front 
panel.

After you start I/O communication, you can view the slave’s input 
bytes on the front panel Input Data indicators, and you can enter new 
output bytes using the front panel Output Data controls. You can use 
these input and output bytes to test and manipulate the physical 
capabilities of your slave device.
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7. Stop the example.

For LabVIEW or BridgeVIEW, click on the Stop button on the 
example’s front panel. If needed, you can still view any errors or other 
information on the front panel.

For LabWindows/CVI, click on the Stop button on the example’s front 
panel. Although I/O communication has stopped, you can still view 
any errors or other information on the front panel. Select the Exit  
button to close the front panel and exit back to the LabWindows/CVI 
environment.

Congratulations on completing your first DeviceNet application! For more 
information about the SingleDevice  example, including a program flow 
chart for the example’s source code, refer to Chapter 4, Application 
Examples, in the NI-DNET User Manual.

General Programming Considerations
As you begin developing your NI-DNET application, remember the 
following points:

• For your LabVIEW or BridgeVIEW application, you must use the 
NI-DNET LabVIEW functions. The NI-DNET functions can be added 
to your LabVIEW palettes by selecting Edit»Select Palette 
Set»nidnet_view from within LabVIEW.

• For LabWindows/CVI applications, you must use the NI-DNET 
functions panels for LabWindows/CVI. These function panels can be 
used by selecting Libraries»NI-DNET  from within 
LabWindows/CVI.

• For your C/C++ application, you must include the NI-DNET header 
file, nidnet.h , in your source code.

• Use the DeviceNet examples included with the NI-DNET software as 
a guide for your own application development.

For information about developing your application, refer to the NI-DNET 
User Manual. For detailed information about NI-DNET functions and 
objects, refer to the NI-DNET Programer Reference Manual.
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A
Uninstalling the Hardware 
and Software

This appendix describes how to uninstall the PXI-8461 hardware and the 
NI-DNET software for Windows 95/98.

Uninstalling the Hardware from Windows 95/98
Before physically removing the board from the computer, you must remove 
the hardware information from the Windows 95/98 Device Manager.

To remove the hardware information from Windows 95/98, complete the 
following steps:

1. Select Start»Settings»Control Panel. 

2. Double-click on the System icon.

3. In the System Properties dialog box that appears, select the 
Device Manager tab.

4. Click on the View devices by type button at the top of the Device 
Manager tab.

5. Double-click on the National Instruments CAN Interfaces icon.
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6. To remove a board, select it from the list of boards under National 
Instruments CAN Interfaces as shown in Figure A-1 and click on the 
Remove button.

Figure A-1.  Selecting an Interface to Remove from Windows 95/98

After you remove the appropriate hardware information from the Device 
Manager, you should shut down Windows, power off your PXI or 
CompactPCI chassis, remove any cables attached to your board, and 
physically remove the board from your computer.
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Uninstalling the NI-DNET Software from Windows 95/98
Before uninstalling the NI-DNET software, you should remove all boards 
from your computer, as explained in the previous section.

Complete the following steps to remove the NI-DNET software:

1. Select the Add/Remove Programs icon under Start»Settings» 
Control Panel. A dialog box similar to the one in Figure A-2 appears. 
This dialog box lists the software available for removal.

Figure A-2.  Add/Remove Programs Properties Dialog Box

2. Select the NI-DNET software you want to remove and click on the 
Add/Remove button. The uninstall program runs and removes all 
folders, utilities, device drivers, DLLs, and registry entries associated 
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with the NI-DNET software. Figure A-3 shows the results of a 
successful uninstallation.

Figure A-3.  NI-DNET Uninstallation Results

The uninstall program removes only items that the installation program 
installed. If you add anything to a directory that was created by the 
installation program, the uninstall program does not delete that directory 
because the directory is not empty after the uninstallation. You must 
remove any remaining components yourself.

If you want to reinstall the hardware and software, refer to Chapter 2, 
Installation.
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B
Cabling Requirements

This appendix describes the cabling requirements for the hardware. 

Cables should be constructed to meet these requirements and the 
requirements of DeviceNet. DeviceNet cabling requirements can be found 
in the DeviceNet Specification.

Connector Pinouts
The PXI-8461 has a Combicon-style pluggable screw terminal connector. 
The 5-pin Combicon-style pluggable screw terminal follows the pinout 
required by the DeviceNet Specification. Figure B-1 shows the pinout for 
this connector. 

Figure B-1.  Pinout for 5-Pin Combicon-Style Pluggable Screw Terminal

CAN_H and CAN_L are signal lines that carry the data on the DeviceNet 
network. These signals should be connected using twisted-pair cable.

For the PXI-8461, V+ and V– supply power to the DeviceNet physical 
layer. See the next section, Power Supply Information for the DeviceNet 
Ports, for more information.
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Power Supply Information for the DeviceNet Ports
For the PXI-8461, the bus must supply power to each DeviceNet port. The 
bus power supply should be a DC power supply with an output of 10 V to 
30 V. The DeviceNet physical layer is powered from the bus using the V+ 
and V– lines. 

The power requirements for the DeviceNet port are shown in Table B-1. 
You should take these requirements into account when determining the 
requirements of the bus power supply for the system.

For the PXI-8461, a jumper controls the source of power for the DeviceNet 
physical layer. The location of this jumper is shown in Figure B-2.

Figure B-2.  PXI-8461 Power Source Jumper

Table B-1.  Power Requirements for the DeviceNet Physical Layer 
for Bus-Powered Versions

Characteristic Specification

Voltage Requirement V+ 10 to 30 VDC

Current Requirement 40 mA typical 
100 mA maximum

1 Power Supply Jumper J5
2 Assembly Number

3 Product Name
4 Serial Number

1
4

2 3
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The PXI-8461 is shipped with this jumper set in the EXT position. In this 
position, the physical layer is powered from the bus (the V+ and V– pins on 
the Combicon connector). The jumper must be in this position for the 
DeviceNet interface to be compliant with the DeviceNet Specification.

If the DeviceNet interface is being used in a system where bus power is not 
available, the jumper may be set in the INT position. In this position, the 
physical layer is powered by the host computer or internally. The physical 
layer is still optically isolated. Figure B-3 shows how to configure your 
jumpers for internal or external power supplies.

Figure B-3.  Power Source Jumpers

Cable Specifications
Cables should meet the requirements of the DeviceNet cable specification. 
DeviceNet cabling requirements can be found in the DeviceNet 
Specification.

Belden cable (3084A) meets all of those requirements and should be 
suitable for most applications.

Cable Lengths
The allowable cable length is affected by the characteristics of the 
cabling and the desired bit transmission rates. Detailed cable length 
recommendations can be found in the DeviceNet Specification. 

INT EXT

a. Internal Power Mode

INT EXT

b. External Power Mode
(DeviceNet)

123 123

Win95.book  Page 3  Thursday, July 23, 1998  8:40 AM



Appendix B Cabling Requirements

Getting Started with DeviceNet for Windows 95/98 B-4 © National Instruments Corporation

Table B-2 lists the DeviceNet cable length specifications.

Maximum Number of Devices
The maximum number of devices you can connect to a DeviceNet network 
depends on the electrical characteristics of the devices on the network. If all 
of the devices on the network meet the DeviceNet specifications, 64 devices 
may be connected to the network, including the PXI-8461.

Cable Termination
The pair of signal wires (CAN_H and CAN_L) constitutes a transmission 
line. If the transmission line is not terminated, each signal change on the 
line causes reflections that may cause communication failures.

Because communication flows both ways on the DeviceNet bus, DeviceNet 
requires that both ends of the cable be terminated. However, this 
requirement does not mean that every device should have a termination 
resistor. If multiple devices are placed along the cable, only the devices on 
the ends of the cable should have termination resistors. See Figure B-4 for 
an example of where termination resistors should be placed in a system 
with more than two devices.

Figure B-4.  Termination Resistor Placement

Table B-2.  DeviceNet Cable Length Specifications

Baud Rate Trunk Length
Drop Length 
Maximum

Drop Length 
Cumulative

500 kb/s 100 m (328 ft.) 6 m (20 ft.) 39 m (128 ft.)

250 kb/s 250 m (820 ft.) 6 m (20 ft.) 78 m (256 ft.)

125 kb/s 500 m (1640 ft.) 6 m (20 ft.) 156 m (512 ft.)

120Ω  120Ω  

CAN_H

CAN_L
DeviceNet

Device

DeviceNet
Device

DeviceNet
Device

DeviceNet
Device
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The termination resistors on a cable should match the nominal impedance 
of the cable. DeviceNet requires a cable with a nominal impedance of 
120Ω; therefore, a 120 Ω resistor should be used at each end of the cable. 
Each termination resistor should each be capable of dissipating at least 
0.25 W of power.

Cabling Example
Figure B-5 shows an example of a cable to connect two DeviceNet devices. 

Figure B-5.  Cabling Example

9-Pin
D-Sub

9-Pin
D-Sub

CAN_H

CAN_L

GND

V+

V+

V–

V–

5-Pin
Combicon

5-Pin
Combicon

Pin 7Pin 4 Pin 7 Pin 4

Pin 2 Pin 2

Pin 5 Pin 3

Pin 9 Pin 5

Pin 3 Pin 1

Pin 2Pin 2

Pin 5Pin 3

Pin 9Pin 5

Pin 3Pin 1

120Ω 120Ω

Power
Connector
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C
Troubleshooting and 
Common Questions

This appendix describes how to troubleshoot problems and answers some 
common questions.

Hardware Configuration Utility Test Failures
The following sections explain common error messages generated by the 
NI-DNET Hardware Configuration utility.

Memory Resource Conflict
This error occurs if the memory resources assigned to a board conflict with 
the memory resources being used by other hardware in the system. 
Resource conflicts typically occur when your system contains legacy 
hardware that uses resources that have not been reserved properly with the 
Device Manager. If a resource conflict exists, write down the memory 
resource that caused the conflict and refer to the Microsoft Windows 95/98 
User’s Guide for instructions on how to use the Device Manager to reserve 
memory resources for legacy hardware. After the conflict has been 
resolved, run the NI-DNET Hardware Configuration utility again.

Interrupt Resource Conflict
This error occurs if the interrupt resources assigned to a board conflict with 
the interrupt resources being used by other hardware in the system. 
Resource conflicts typically occur when your system contains legacy 
hardware that uses resources that have not been reserved properly with the 
Device Manager. If a resource conflict exists, write down the interrupt 
resource that caused the conflict and refer to the Microsoft Windows 95/98 
User’s Guide for instructions on how to use the Device Manager to reserve 
interrupt resources for legacy hardware. After the conflict has been 
resolved, run the NI-DNET Hardware Configuration utility again.
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NI-DNET Software Problem Encountered
This error occurs if the NI-DNET Hardware Configuration utility detects 
that it is unable to communicate correctly with the hardware using the 
installed NI-DNET software. If you get this error, shut down your 
computer, restart it, and run the NI-DNET Hardware Configuration utility 
again. If the problem persists, try reinstalling the NI-DNET software for 
Windows 95/98. 

Missing Board in Hardware Configuration Utility
If a board is physically installed in your system, but is not listed in the 
NI-DNET Hardware Configuration utility, check the Windows 95/98 
Device Manager to see if Windows 95/98 has detected the board. For more 
information, refer to the next section, Device Manager Problems.

Hardware Problem Encountered
This error occurs if the NI-DNET Hardware Configuration utility detects a 
defect in the hardware. If you get this error, write down the numeric code 
shown with the error and contact National Instruments. Depending on the 
cause of the hardware failure, you may need to repair or replace your board.

Device Manager Problems
The Windows Device Manager contains configuration information for all 
of the hardware it is aware of in your system. To start the Windows Device 
Manager, double-click on the System icon under Start»Settings»Control 
Panel. In the System Properties box that appears, select the Device 
Manager tab and click the View devices by type radio button at the top of 
the tab. 

If there is no National Instruments CAN Interfaces item and you are 
certain your board is installed, refer to the No National Instruments CAN 
Interfaces section of this appendix. This problem occurs when Windows 
does not display the New Hardware Found dialog box when expected.

If the National Instruments CAN Interfaces item exists, but the board 
you are looking for is not listed there, refer to the Missing Board in Device 
Manager section of this appendix.

If the board you are looking for is listed but has a circled X or exclamation 
mark (!) over its icon, refer to the Problem Shown in Device Manager 
section of this appendix.

Win95.book  Page 2  Thursday, July 23, 1998  8:40 AM



Appendix C Troubleshooting and Common Questions

© National Instruments Corporation C-3 Getting Started with DeviceNet for Windows 95/98

No National Instruments CAN Interfaces
If you are certain your board is installed, but no National Instruments 
CAN Interfaces item appears in the Device Manager, the board is 
probably incorrectly listed under Other Devices. This problem occurs 
when Windows does not display the New Hardware Found dialog box 
when expected. To fix the problem, complete the following steps:

1. Select Start»Settings»Control Panel.

2. Double-click on the System icon to display the System Properties 
dialog box for the computer.

3. Click on the Device Manager tab at the top of the System Properties 
sheet to bring up the Device Manager property page. Make sure the 
View devices by type button at the top of the Device Manager page 
is selected.

4. Click on the + sign next to Other Devices to display a list of all the 
hardware devices that Windows has detected and configured as Other 
Devices. 

5. For each PXI-8461 listed, select the board by clicking on it, and then 
click on the Remove button to remove each board from the list of 
Other Devices.

6. After you have removed all of the PXI-8461 boards from the list of 
Other Devices, click on the Refresh button to force Windows to detect 
each PXI-8461 and to display a New Hardware Found dialog box for 
each one. Your PXI-8461 boards should now appear under National 
Instruments CAN Interfaces.

7. Verify the installation as described in Chapter 3, Verify the 
Installation.

Missing Board in Device Manager
If the National Instruments CAN Interfaces item exists, but the board 
you are looking for is not listed there, the board is not properly installed. 
This problem indicates that the board is not physically present in the 
system. Make certain that the board is fully inserted.

Problem Shown in Device Manager
If a DeviceNet interface is not working properly, its icon has a circled X or 
exclamation mark (!) overlaid on it, as shown in Figure C-1. 
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Figure C-1.  Device Manager with PXI-8461 Interface Not Working Properly

This problem can occur for several reasons. If you encounter this problem, 
the Device Manager should list an error code that indicates why the 
problem occurred. To see the error code for a particular interface, select the 
name of the interface and click on the Properties button to go to the 
General tab for that DeviceNet interface. The Device Status section of the 
General tab shows the error code. Locate the error code in the following 
list to find out why your DeviceNet interface is not working properly.

Code 8: The NI-DNET software was incompletely installed. To solve 
this problem, reinstall the NI-DNET software for Windows.

Code 9: Windows had a problem reading information from your 
interface. Contact National Instruments for assistance.

Code 12: Your interface was not assigned a physical memory range. If 
your computer does not have 8 KB of available memory, 
Windows might configure your interface without a physical 
memory assignment. The NI-DNET software cannot function 
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without 8 KB of physical memory. Another way to verify this 
problem is to look at the Resource settings list on the 
Resources tab to verify that the interface was not assigned a 
Memory Range. To solve this problem, free up an 8 KB 
Memory Range (such as D0000 to D1FFF hex) that is being 
used by another device in the system.

Code 15: Your interface was not assigned an Interrupt Request level. If 
your computer does not have any available Interrupt Request 
levels, Windows might configure your interface without an 
Interrupt Request level. The NI-DNET software cannot 
function without an Interrupt Request level. Another way to 
verify this problem is to look at the Resource settings list on 
the Resources tab to verify that your interface was not assigned 
an Interrupt Request level. To solve this problem, free up an 
Interrupt Request level that is being used by another device in 
the system.

Code 22: Your interface is disabled. To enable your interface, check the 
appropriate configuration checkbox in the Device Usage 
section of the General tab.

Code 24: Your interface is not present, or the Device Manager is unaware 
that your interface is present. To solve this problem, select your 
interface in the Device Manager, and click on the Remove 
button. Next, click on the Refresh button. At this point, the 
system rescans the installed hardware, and your interface 
should show up without any problems. If the problem persists, 
contact National Instruments.

Code 27: Windows was unable to assign the DeviceNet interface any 
resources. To solve this problem, free up system resources by 
disabling other unnecessary hardware so that enough resources 
are available for the DeviceNet interface. The resources 
required for a single DeviceNet interface are an Interrupt 
Request level and an 8 KB physical memory range (such as 
D0000 to D1FFF hex).
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Common Questions
What do I do if my board is listed in the Windows Device Manager with 
a circled X or exclamation point (!) overlaid on it?

Refer to the Problem Shown in Device Manager section of this appendix 
for specific information about what might cause this problem. If you have 
already completed the troubleshooting steps, fill out the forms in 
Appendix E, Customer Communication, and contact National Instruments. 

How can I determine which version of the NI-DNET software I have 
installed?

Run the NI-DNET Hardware Configuration utility. To run the utility, select 
the Hardware Configuration item under Start»Programs»NI-DNET 
Software, then select the About item under the Help menu. The NI-DNET 
utility displays information about the version of the NI-DNET software 
currently installed.

Which DeviceNet boards does the NI-DNET software support?

The NI-DNET software for Windows 95/98 supports the AT-CAN, 
PCI-CAN, PCMCIA-CAN, and PXI-8461. Although the AT-CAN/2, 
PCI-CAN/2, PCMCIA-CAN/2, and PXI-8461 2-port work with NI-DNET, 
only port 1 can be used. Port 2 cannot be used with NI-DNET.

Does NI-DNET support two-port DeviceNet boards?

No. Refer to the previous question for more information.

What do I do if the NI-DNET Hardware Configuration utility test fails 
with an error?

Refer to the Hardware Configuration Utility Test Failures section of this 
appendix for specific information about what might cause the test to fail. If 
you have already completed the troubleshooting steps, fill out the forms in 
Appendix E, Customer Communication, and contact National Instruments.

How many DeviceNet boards can I configure for use with my NI-DNET 
software for Windows 95/98? 

The NI-DNET software can be configured to communicate with up to 10 
boards. 
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Are interrupts required for the PXI-8461?

Yes, one interrupt per board is required. You can set interrupts using the 
Resources tab of the Hardware Configuration utility.

How do I use NI-DNET within my programming environment?

For information about using NI-DNET from within LabVIEW, 
BridgeVIEW, LabWindows/CVI, Microsoft C, and other programming 
environments, refer to the NI-DNET User Manual.

Why does the uninstall program leave some components installed?

The uninstall program removes only items that the installation program 
installed. If you add anything to a directory that was created by the 
installation program, the uninstall program does not delete that directory 
because the directory is not empty after the uninstallation. You must 
remove any remaining components yourself.

How can I monitor low-level CAN frames on a DeviceNet network?

You can use your PXI-8461 with National Instruments NI-CAN software. 
The NI-CAN software is suited to general purpose CAN applications, such 
as automotive tests, and can receive all CAN frames on a DeviceNet 
network. Using NI-CAN for this purpose generally requires a detailed 
knowledge of the DeviceNet Specification. For more information on 
NI-CAN, refer to the README.TXT file in your NI-DNET installation 
directory.

What is NI-CAN?

NI-CAN is National Instruments software for general-purpose access to 
Controller Area Network (CAN). CAN is the underlying communications 
protocol used by DeviceNet. Unless you have a detailed knowledge of the 
DeviceNet Specification and you need to implement portions of that 
specification within your application, NI-DNET is the preferable method 
for accessing a DeviceNet network. For more information on NI-CAN, 
refer to the README.TXT file in your NI-DNET installation directory.

What information should I have before I call National Instruments?

When you call National Instruments, you should have all of the information 
filled out on the Hardware and Software Configuration Form in 
Appendix E, Customer Communication.
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D
Specifications

This appendix describes the physical characteristics of the hardware and 
the recommended operating conditions.

Table D-1.  PXI-8461 Characteristics

Characteristic Specification

Dimensions 100 by 160 mm
(3.94 by 6.30 in.)

Power Requirement +5 VDC 775 mA typical

I/O Connector 5-pin Combicon-style pluggable 
DeviceNet screw terminal

Operating Environment
Component Temperature
Relative Humidity

0° to 55° C
10% to 90%, noncondensing

Storage Environment
Temperature
Relative Humidity

–20° to 70° C
5% to 90%, noncondensing

EMI FCC Class A verified

Table D-2.  DeviceNet Port Characteristics for Bus-Powered Ports

Characteristic Specification

Power Requirement 10 to 30 V 40 mA typical
100 mA maximum

Isolation 500 VDC optical
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E
Customer Communication

For your convenience, this appendix contains forms to help you gather the information necessary 
to help us solve your technical problems and a form you can use to comment on the product 
documentation. When you contact us, we need the information on the Technical Support Form and 
the configuration form, if your manual contains one, about your system configuration to answer your 
questions as quickly as possible.

National Instruments has technical assistance through electronic, fax, and telephone systems to quickly 
provide the information you need. Our electronic services include a bulletin board service, an FTP site, 
a fax-on-demand system, and e-mail support. If you have a hardware or software problem, first try the 
electronic support systems. If the information available on these systems does not answer your 
questions, we offer fax and telephone support through our technical support centers, which are staffed 
by applications engineers. 

Electronic Services

Bulletin Board Support
National Instruments has BBS and FTP sites dedicated for 24-hour support with a collection of files 
and documents to answer most common customer questions. From these sites, you can also download 
the latest instrument drivers, updates, and example programs. For recorded instructions on how to use 
the bulletin board and FTP services and for BBS automated information, call 512 795 6990. You can 
access these services at:

United States: 512 794 5422
Up to 14,400 baud, 8 data bits, 1 stop bit, no parity

United Kingdom:  01635 551422
Up to 9,600 baud, 8 data bits, 1 stop bit, no parity

France:  01 48 65 15 59
Up to 9,600 baud, 8 data bits, 1 stop bit, no parity

FTP Support
To access our FTP site, log on to our Internet host, ftp.natinst.com , as anonymous  and use 
your Internet address, such as joesmith@anywhere.com , as your password. The support files and 
documents are located in the /support  directories.
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Fax-on-Demand Support
Fax-on-Demand is a 24-hour information retrieval system containing a library of documents on a wide 
range of technical information. You can access Fax-on-Demand from a touch-tone telephone at 
512 418 1111.

E-Mail Support (Currently USA Only)
You can submit technical support questions to the applications engineering team through e-mail at the 
Internet address listed below. Remember to include your name, address, and phone number so we can 
contact you with solutions and suggestions. 

support@natinst.com

Telephone and Fax Support
National Instruments has branch offices all over the world. Use the list below to find the technical 
support number for your country. If there is no National Instruments office in your country, contact 
the source from which you purchased your software to obtain support.

Country Telephone Fax
Australia 03 9879 5166 03 9879 6277
Austria 0662 45 79 90 0 0662 45 79 90 19
Belgium 02 757 00 20 02 757 03 11
Brazil 011 288 3336 011 288 8528
Canada (Ontario) 905 785 0085 905 785 0086
Canada (Quebec) 514 694 8521 514 694 4399
Denmark 45 76 26 00 45 76 26 02
Finland 09 725 725 11 09 725 725 55
France 01 48 14 24 24 01 48 14 24 14
Germany 089 741 31 30 089 714 60 35
Hong Kong 2645 3186 2686 8505
Israel 03 6120092 03 6120095
Italy 02 413091 02 41309215
Japan 03 5472 2970 03 5472 2977
Korea 02 596 7456 02 596 7455
Mexico 5 520 2635 5 520 3282
Netherlands 0348 433466 0348 430673
Norway 32 84 84 00 32 84 86 00
Singapore 2265886 2265887
Spain 91 640 0085 91 640 0533
Sweden 08 730 49 70 08 730 43 70
Switzerland 056 200 51 51 056 200 51 55
Taiwan 02 377 1200 02 737 4644
United Kingdom 01635 523545 01635 523154
United States 512 795 8248 512 794 5678
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Technical Support Form
Photocopy this form and update it each time you make changes to your software or hardware, and use 
the completed copy of this form as a reference for your current configuration. Completing this form 
accurately before contacting National Instruments for technical support helps our applications 
engineers answer your questions more efficiently.

If you are using any National Instruments hardware or software products related to this problem, 
include the configuration forms from their user manuals. Include additional pages if necessary.

Name __________________________________________________________________________

Company _______________________________________________________________________

Address ________________________________________________________________________

_______________________________________________________________________________

Fax ( ___ ) ________________Phone ( ___ ) __________________________________________

Computer brand ___________ Model __________________Processor _____________________

Operating system (include version number) ____________________________________________

Clock speed ______MHz   RAM _____MB Display adapter __________________________

Mouse ___yes   ___no     Other adapters installed_______________________________________

Hard disk capacity _____MB Brand ________________________________________________

Instruments used _________________________________________________________________

_______________________________________________________________________________

National Instruments hardware product model _____________ Revision  ____________________

Configuration ___________________________________________________________________

National Instruments software product ___________________ Version  _____________________

Configuration ___________________________________________________________________

The problem is: __________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

List any error messages: ___________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

The following steps reproduce the problem: ___________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________
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Hardware and Software Configuration Form
Record the settings and revisions of your hardware and software on the line to the right of each item. 
Complete a new copy of this form each time you revise your software or hardware configuration, and 
use this form as a reference for your current configuration. Completing this form accurately before 
contacting National Instruments for technical support helps our applications engineers answer your 
questions more efficiently.

National Instruments Products
Information from NI-DNET Hardware Configuration Utility
Hardware type (such as PXI-8461) __________________________________________________

Diagnostic Status ________________________________________________________________

Resources: Interrupt Request ___________________  Memory Range _____________________

Serial Number __________________________________________________________________

Hardware Revision ______________________________________________________________

NI-DNET Software Version (Help»About) ___________________________________________

Other Products
Resource Summary Report from the Device Manager
To create this report, first display the System Properties dialog box for the computer by 
double-clicking on the System icon under Start»Settings»Control Panel. Then click on the 
Device Manager tab and highlight the Computer icon. Click on the Print  button, and check the 
Print to File  checkbox in the Print  dialog box before clicking on OK .

Programming Environment Information

Programming Language ___________________________________________________________

Compiler Vendor ________________________________________________________________

Compiler Version ________________________________________________________________

Application Information

LabVIEW, BridgeVIEW, LabWindows/CVI Application _________________________________

Win32 Application _______________________________________________________________

If Win 32, method of accessing DLL (link with language interface or direct entry?) ____________

______________________________________________________________________________
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Documentation Comment Form
National Instruments encourages you to comment on the documentation supplied with our products. 
This information helps us provide quality products to meet your needs.

Title: Getting Started with Your PXI-8461 and the NI-DNET ™ Software 
for Windows 95/98

Edition Date: April 1998

Part Number: 321973A-01

Please comment on the completeness, clarity, and organization of the manual.

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

If you find errors in the manual, please record the page numbers and describe the errors.

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

Thank you for your help.

Name _________________________________________________________________________

Title __________________________________________________________________________

Company _______________________________________________________________________

Address ________________________________________________________________________

_______________________________________________________________________________

E-Mail Address __________________________________________________________________

Phone ( ___ ) __________________________  Fax ( ___ ) _______________________________

Mail to: Technical Publications Fax to: Technical Publications
National Instruments Corporation National Instruments Corporation
6504 Bridge Point Parkway 512 794 5678
Austin, Texas 78730-5039
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Glossary

Prefix Meanings Value

m- milli- 10–3

k- kilo- 103

M- mega- 106

° degrees

Ω ohms

% percent

A amperes

ANSI American National Standards Institute

applet program that can only be used within another application

b bits

B bytes

C Celsius

CAN Controller Area Network

change-of-state I/O Master/slave I/O connection which is similar to cyclic I/O, but data can be 
sent when a change in the data is detected

CiA CAN in Automation

cyclic I/O Master/slave I/O connection in which the slave (or master) sends data at a 
fixed interval

DC Direct Current

DLL dynamic link library

EMI electromagnetic interference

FCC Federal Communications Commission

ft. feet

FTP File Transfer Protocol
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HMI Human-machine interface

Hz hertz

IEEE Institute of Electrical and Electronic Engineers

in. inches

I/O input/output

ISO International Standards Organization

KB kilobytes

LED light-emitting diode

m meters

MAC ID Media Access Control Layer Identifier

master/slave DeviceNet communication scheme in which a master device allocates 
connections to one or more slave devices, and those slave devices can only 
communicate with the master and not one another.

MB megabyte

PC personal computer

PCI peripheral component interconnect

PLC Programmable Logic Control

polled I/O Master/slave I/O connection in which the master sends a poll command to 
a slave, then receives a poll response from that slave.

RAM random-access memory

resource hardware settings used by National Instruments CAN hardware, including 
an interrupt request level (IRQ) and an 8 KB physical memory range (such 
as D0000 to D1FFF hex)

s seconds

SCADA Supervisory Control and Data Acquisition

strobed I/O Master/slave I/O connection in which the master broadcasts a single strobe 
command to all strobed slaves then receives a strobe response from each 
strobed slave

V volts

VDC volts direct current
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VXI VME eXtensions for Instrumentation

W watts
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